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1 Introduction 

1.1 About Malware 
 

Malware is one of the biggest problems facing IT infrastructure, businesses, and 

governments alike. According to some estimates, cybercriminals who use malware to steal credit 

card information and other personal data cost the global economy as much as $1 trillion dollars 

per year.
1
 Malware can come into a network over port 80, the Hypertext Transfer Protocol 

(HTTP), and can infect any machine connected to the Internet. A user will usually become 

infected with malware by visiting a web page that is infected. Other ways of obtaining harmful 

malware include opening infected e-mail attachments and running malicious executable (.exe) 

files.
2
  

IT professionals have known how malware works for many years now.
3
 Most malware 

today uses one of a variety of templates, which are readily available for download and 

modification on the Internet. When malware is first downloaded to a machine, it is often in a 

benign state. This meaning that the malware is not harmful to the host system, for a time at least. 

In order for the malware to become harmful, it needs to be activated by receiving commands 

from its Command and Control Center, which is a server located somewhere on the Internet that 

sends instructions to the malware. 

In previous years, less sophisticated malware contacted a specific IP address such as 

74.168.2.11 in order to receive instructions. IT professionals easily countered this by simply 

blocking that IP address. Unfortunately, malware has evolved. Today, malware uses complex 

algorithms to generate pseudo-random domain names. These pseudo-random domain names 

change rapidly in a process known as domain fluxing. Domain fluxing allows the malware to 

rapidly change domain names to predictable names, that is, as long as you know the numeric 
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seed in the malware’s algorithm.
4
 Otherwise, it is largely impossible to guess the domain name 

in order to block it. As you can imagine, this makes malware much more difficult to stop. Figure 

1.1.1 illustrates this domain name interaction with the infected machine, the DNS Server, and the 

Command and Control Center. 

 

Figure 1.1.1 – How It Works 

 

1.2 The Situation  
 

The University of Cincinnati Information Technology’s (UCIT) Office of Information 

Security wanted to try and detect potential infected machines by utilizing network traffic 

analysis, specifically DNS traffic. Every time a unit of malware attempts to contact its host 

server, even if the malware is in a benign state, it must go through the DNS server, which 
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translates the domain name to an IP address. An example of a proper domain lookup would be 

typing www.google.com into a web browser and the DNS Server translating that name to the IP 

address 74.125.26.103.This can be seen in figure 1.2.1 when using ping to test the connection 

with www.google.com.  

 

Figure 1.2.1 – Proper Domain Name Lookup via Ping 

  

If the host name does not exist, which is often the case with malware and domain-fluxing, 

then the DNS logs will indicate that an NX response, or no response, was sent back to the DNS 

server. An example of a domain that would generate an NX response from the DNS server would 

be www.fvjsoiwhsfawqqdaodjan.com, which is clearly a fake domain name generated by an 

algorithm. Figure 1.2.2 below shows a Wireshark reading of a fake domain name. 

 

Figure 1.2.2 – NX Response from a Fake Domain Name 

 

http://www.google.com/
http://www.google.com/
http://www.fvjsoiwhsfawqqdaodjan.com/


Alkhateeb 9 
 

 

Knowing this, the DNS traffic can be logged and the frequency of these NX responses can be 

measured in order to determine or predict which IP addresses are infected with malware even if 

the malware is still in its benign state. 

Using this information, the UCIT Office of Information Security could find malware 

before it becomes a problem on the university network. They would be able to quarantine it or, at 

the very least, make note of which IP addresses potentially house malware. Then, the security 

professionals over at the UCIT Office of Information Security could use their best judgment to 

proceed with either removing the malware or carefully monitoring the situation.   

 

1.3 Programs and Tools Used 
 

 The programs and tools used for this project were: 

• Microsoft Windows 8 – operating system 

• Wireshark v.1.8.6 – to gather DNS logs and create detailed, custom columns 

• Microsoft SQL Server 2012 – for creating a database to house the data and for data 

mining 

• IBM Statistical Package for the Social Sciences (SPSS) Statistics and Text 

Analytics – for analysis of domain names 

 

1.4 Deliverables 
 

There were three deliverables for this project: 

1. DNS logs with NX response codes (.cap and CSV format) 

2. A database of all response codes (Microsoft SQL Server 2012) 
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3. The analysis of the data (IBM SPSS Output) 

 

1.5 The Solution 
  

This project successfully produced a list of infected IP addresses as well a list of 

ambiguous IP addresses that may or may not contain infections for the UCIT Office of 

Information Security. The ambiguous list is relatively short, but it was necessary due to the 

nature of text analytics. Some domain names were false positives. In other words, they looked 

like fake domain names, but were actually real. Potential false positives were dumped into a 

second list in order to separate them from the ones which were actually infected. 

The raw DNS logs are also available as well as the CSV files and Wireshark files. A 

database was also created in Microsoft’s SQL Server 2012 to house the data. Finally, and most 

importantly, an IBM SPSS Output file was created that includes all the infected IP addresses, 

their associated domain names, frequency tables, and a table with 1.4 million records of data. 

 

2 Methods 

2.1 Gathering DNS Logs 
 

The DNS logs were gathered in the UC Network Operations Center with a computer 

connected to the DNS sever. The IP address of UC’s main DNS server is 10.27.3.2. Wireshark 

was used to log the packets at two separate intervals for a total of 15 minutes each. Therefore, the 

total allotted time for gathering logs was 30 minutes. This does not seem like much, but in reality 

this is over 1.2 GB of data and over 1.4 million records of text data. This is enough to give us an 
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accurate sample of UC’s traffic during the average weekday. Figure 2.1.1 shows a small sample 

of the DNS logs gathered via Wireshark. 

 

Figure 2.1.1 – Sample of Wireshark DNS Log 

 

However, by default Wireshark does not allow for much column detail. The columns you 

see in Figure 2.1.1 are actually custom columns created by me. A new addition to Wireshark in 

version 1.8 is the ability to create custom columns based on custom filters. This was highly 

important because it gave the ability to separate the specific domain names into a separate 

column, as well as various other useful descriptors such as DNS Query Type and Response 

Code.  

In order to add the custom filters the following method was used: 

1. In Wireshark, first go to Edit -> Preferences (Figure 2.1.2) 



Alkhateeb 12 
 

 

 

Figure 2.1.2 – Wireshark Preferences 

 

2. Then, on the left pane under User Interfaces, click Columns (Figure 2.1.3) 

 

Figure 2.1.3 – Wireshark Column Preferences 
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3. Click on the down arrow next to the Field Type label to pull up a list box for available 

columns, one of them is called Custom (Figure 2.1.4) 

 

Figure 2.1.4 – Wireshark Custom Field Type 

 

4. Now, in the Field Name text box enter the filter expression from the Wireshark filters 

menu that you would like to be a separate column. For example, we will use 

dns.qry.name to give us a column for Domain Name. (Figure 2.1.5) 

 

Figure 2.1.5 – Wireshark Custom Field Name 

 

5. Click Add to add the new custom column and repeat for any other custom columns 

6. Click OK 

 

 

 

 

NOTE: To find out which custom filter expressions are available you can navigate to the 

Expression button in Wireshark and navigate through the listing as shown in Figure 2.1.6. 
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Figure 2.1.6 – Wireshark Filter Expressions 

 

2.2 Outputting Wireshark Data to CSV 
  

Once the log data was properly gathered and had the proper custom columns, the logs had 

to be output to Comma Separated Values (CSV) format. This was necessary in order to create a 

database in Microsoft SQL Server 2012 and for easy importation into IBM SPSS.  

In order to output the Wireshark logs to CSV format the following method was used:  
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1. In Wireshark go to File -> Export Packet Dissections -> as “CSV” (Comma separated 

values summary) file… (Figure 2.2.1) 

 

Figure 2.2.1 – Wireshark Export Packet Dissections to CSV 

 

2. Then, name the file whatever you choose, in our case Traffic1_CSV (Figure 2.2.2) 
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Figure 2.2.2 – Wireshark Saving CSV Export 

3. Click Save 

 

2.3 Importing CSV Data to Microsoft SQL Server 2012 
  

With the CSV data now available, the following step was to dump that data into a 

Microsoft SQL Server 2012 database table. I already had a database named “Traffic” created to 

house the new table. In order to dump the CSV data into the existing “Traffic” database, some 

code had to be written in Structured Query Language (SQL) to manually create a new table, 

populate the table, and then check to make sure the table was created properly.  

The queries used go as follows: 
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To create the table: 

USE Traffic 
GO 
CREATE TABLE CSVTest 
( 
 ID INT, 
 TimeX VARINT(MAX), 
 SourceIP VARCHAR(MAX), 
 DestIP VARCHAR(MAX), 
 SourcePort VARCHAR(MAX), 
 DestPort VARCHAR(MAX), 
 DomainName VARCHAR(MAX), 
 DNSQueryType VARCHAR(MAX), 
 DNSQueryClass VARCHAR(MAX), 
 Protocol VARCHAR(MAX), 
 LengthX INT, 
 Info VARCHAR(MAX) 
) 
GO 

 

To populate the table with CSV data: 

BULK 
INSERT CSVTest 
FROM 'c:\Traffic1_CSV.csv' 
WITH 
( 
 FIELDTERMINATOR = ',', 
 ROWTERMINATOR = '\n' 
) 
GO 

 

To verify that the table was created properly: 

SELECT *  
FROM CSVTest 
GO 
 

 

Using this table, Analysis Services was used to try and find meaningful correlations in 

the data. Microsoft SQL Server 2012 also allows for easy importation in IBM SPSS, which was 

also very useful to the project. Figure 2.3.1 shows a sample of the table when properly 

completed. 
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Figure 2.3.1 – Table in Microsoft SQL Server 2012 

 

2.4 Importing CSV Data to IBM SPSS 
  

The frequency analysis of the fake domain names occurred in IBM SPSS. Therefore, it 

was crucial that the CSV data that was created from Wireshark be imported correctly into IBM 

SPSS. Fortunately, the process itself was relatively simple in comparison to the import process 

for Microsoft SQL Server 2012. 

In order to import the CSV data to IBM SPSS the following method was used: 

1. Launch IBM SPSS and go to File -> Open -> Data… (Figure 2.4.1) 

 

Figure 2.4.1 – IBM SPSS Open Data 

2. In the Files of Type drop-down menu, select Text (Figure 2.4.2) 
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Figure 2.4.2 – IBM SPSS File Type 

3. Navigate to the appropriate CSV location and highlight the CSV file 

4. Click Open 

 

 

 

 

3 Results 

3.1 Results from IBM SPSS Frequency Analysis 
  

 The complete results from the IBM SPSS Frequency Analysis can be found in the file 

Ouput1_Frequency.spv. Due to the size of the file and the sheer number of infected and 

ambiguous IP addresses, not all of them will be shown in this report. However, significant 

samples of the results will be displayed. The type of analysis done on the data is called a 

frequency analysis. Basically, this means that the frequency of NX response codes due to fake 

NOTE: This process could take a long time. In this case, it took several hours considering 

the sheer size (1.4 million records) of the data being handled. 
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domain names was measured. IP addresses far above average +2 standard deviations from the 

mean were automatically placed in the infected list. In order to do this, first I filtered out 

extremely common domain names such as uc.edu, google.com, and Akamai. I also filtered out 

any VMWare domain names. These simple filters covered approximately 80% of the traffic. A 

sample output of these valid domain names and their frequencies can be seen in Figure 3.1.1. 

  

Figure 3.1.1 – SPSS Results Valid Domain Names 

 

Notice in Figure 3.1.1 that the majority of valid domain names are coming from uc.edu 

addresses. While it is technically not impossible that malware could be using an uc.edu address, 

it is highly improbable and would be far too sophisticated for this method of malware detection. 

If something like that were to happen, it would have to be a custom malware written specifically 

to use UC’s network.  
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A list of ambiguous addresses could also be found in the data set under the Summarize 

section of the right pane of the SPSS output. Figure 3.1.2 shows some of these ambiguous 

domain names and their associated IP addresses. 

Figure 3.1.2 – SPSS Results Ambiguous Domain Names 

Finally, a large list of infected IP addresses was created underneath the second set of 

Frequency analysis in the right pane of SPSS underneath Destination. A sample of these can be 

seen in Figure 3.1.3. 

 

Figure 3.1.3 – List of Potentially Infected IP Addresses 
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3.2 Failed Results from Microsoft SQL Server 2012 Data Mining 
  

 Data mining by using the imported CSV data yielded no useful results through normal 

data mining techniques. By attempting to data mine, the project was hoping to find meaningful 

correlations between the various detail columns and the fake domain queries. Unfortunately, it 

turns out that malware is incredibly diverse and can have a wide array of detail within each DNS 

request. Each one can be completely different from every other one. Therefore, the best way to 

reliably predict malware is to look specifically at the frequency of fake domain name requests 

and not the details that define each individual DNS packet.
5  

 

4 Budget 
 

Table 4.1 illustrates the budget for this project. It details both the cost that I paid as well 

as approximate cost that an enterprise should expect to pay in order to carry it out. It should be 

noted that these figures do not include the hours required by employees to do the project because 

that can be extremely variable depending on the company and who does the project. As a 

student, I had access to free copies of Microsoft Windows 8 and Microsoft SQL Server 2012 

Standard Edition due to the MSDNAA© partnership between the University of Cincinnati and 

Microsoft. I was also able to receive a free IBM SPSS Academic trial for six months from IBM 

after contacting an IBM representative and explaining the project. Of course, Wireshark is open 

source and therefore free for anyone to use.  

Unfortunately, a company will have to pay in order to recreate this project. However, 

most companies tend to own Windows licensing and some sort of database and Business 

Intelligence software whether it is Microsoft, Oracle, or the open source MySQL. The only extra 
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expense at that point would be IBM SPSS. The Statistical Analysis System (SAS) could be used 

in place of IBM SPSS since it tends to be the industry standard and is an extremely powerful 

Business Intelligence and Business Analytics tool. 

 

Table 4.1 – Budget for the Project 

 

5 Conclusion 
  

The results of this project will give the UC Office of Information Security the 

information necessary to better protect the university’s data from malware. Listed in the results 

are hundreds of potentially infected IP addresses that need to be appropriately taken care of. 

These machines could house either benign or active malware and are a threat to both data 

 Budget for Me Budget for Enterprise 

MS Windows 8 $0 MSDNAA ~$188 (licensing)
6
 

SQL Server 2012 Standard $0 MSDNAA 

~$898 (per server for standard) 
7
 

~$8592 (Enterprise BI per 

server)
8
 

IBM SPSS $0 Academic Trial 

~$5,270 (per Standard Authorized 

User license)
9
 

Wireshark v.1.8.6 $0 Open Source $0 Open Source 

Totals $0 ~$6,356 to $14,050 

http://www.microsoft.com/en-us/sqlserver/editions/2012-editions/enterprise.aspx
http://www.microsoft.com/en-us/sqlserver/editions/2012-editions/enterprise.aspx
http://www.microsoft.com/en-us/sqlserver/editions/2012-editions/enterprise.aspx
https://www-112.ibm.com/software/howtobuy/buyingtools/paexpress/Express?P0=E1&part_number=D0EKZLL,D0EEMLL,D0EK0LL,D0EEJLL&catalogLocale=en_US&locale=en_US&country=USA&PT=html
https://www-112.ibm.com/software/howtobuy/buyingtools/paexpress/Express?P0=E1&part_number=D0EKZLL,D0EEMLL,D0EK0LL,D0EEJLL&catalogLocale=en_US&locale=en_US&country=USA&PT=html
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integrity and data confidentiality. Thankfully, this project succeeded in identifying malware by 

IP address, but much work needs to be done by the UC Office of Information Security in 

tracking down the individual infected machines. 

Advantages to this project include low cost, network-wide malware detection, and 

detection of malware in its benign state. Disadvantages include having to manually analyze the 

data at regular intervals, requiring someone with both computer networking and Business 

Intelligence skills, and the sheer size and cumbersomeness of DNS logs. Overall, I would say 

this project is worthwhile to any company which has the personnel capable of carrying it out. It 

is one of the only ways currently available to detect malware in its benign state before it becomes 

active. 

 Information security is often similar to personal hygiene. If you do it correctly, then no 

one really notices and everything goes as planned. However, if you do it incorrectly, then you 

could have a potentially bad and embarrassing time. In this way, projects like this one, if done 

periodically, can provide tremendous value to any institution including UC by helping to keep 

malware at bay before it starts to cause serious damage. Large individual businesses spend an 

average of $3.8 million on dealing with cyber threats.
10 

This project can hopefully save some of 

that money so that it may be used to better the business and the world in other ways. 
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